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Useful Information About this User Guide

Useful Information About this User
Guide

Questions About the User Guide

Before reading the User Guide, you may have some questions. In this section
we answer several questions about the User Guide.

Who is the Guide intended for?

This User Guide is intended for users wishing to use the C3000 in conjunction
with Outlook. It doesn't matter whether you use the User Guide in printed form
or online.

What information is available in the User Guide?

This User Guide provides information necessary to work as a user of C3000
for Outlook.

What information is not in the User Guide?

This User Guide does not contain any information about connecting C3000 to
telecommunication systems or configuration of ISDN cards.

This User Guide does not contain any information about installation, configu-
ration or administration of C3000.

This User Guide does not contain any information about the telephone user
interface (TUI).

How is the User Guide Structured?
This User Guide describes how to use C3000 for Outlook.
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Useful Information About this User Guide

Which issue of the User Guide is this?

The following table contains information about this issue of the User Guide.

Explanation
Created on 01/14/2010
Basis C3000 Edition 1.0
Author Andreas Marquardt, Claudia Handel
Available as PDF (Acrobat Reader) file

What has changed?

The following table shows the history of this document.

Version Date Change
20 01/14/2010 New Release
2.1 01/14/2011 - Play voice message on the phone

Where can you find more information?

Additional information on the UMS is available in the following manuals:

» C3000 Installation Manual (installation, configuring ISDN cards, Connec-
ting to telecommunication systems)

* C3000 Administrator Manual

* C3000 TUIl User Manual

« TTrace Installation and Configuration Manual
» TTraceConsole Instruction Manual
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Introduction

Introduction

C3000 Unified Messaging for Microsoft Outlook

C3000 Unified Messaging

In all communications processes, company employees are supported by
modern technologies which at present still utilize different media: Voice mail,
email, fax and SMS text messaging. For the employees this means they must
use and constantly check a variety of different, separate inboxes for mes-
sages. For the company this means several separate systems are operated
and administered alongside each other in an expensive and time-consuming
way. Consolidating all information channels onto one single user interface
makes employees' workflows much more efficient and cuts out redundant
administration processes: C3000 Unified Messaging.

Communication without Media Breaks

C3000 Unified Messaging provides users with centralized access to all mes-
sages in a mail box. Whether phone calls, faxes, emails or SMS text mes-
sages; all information can be received, edited and sent using a unified user
interface. In this way, Unified Messaging ensures that no messages are lost
and that recipients are always reached promptly. The information is accessed
using your familiar everyday work system: Microsoft Outlook. This means you
can reorganise all communication processes to be more user-friendly and to
react more quickly, without any additional training. Highly cost-effective in
every way: Unified Messaging will bring your company significant cost
savings, as well as delivering a faster return on investment. Harmonizing all
communications services under a single user interface like Outlook means
that, with the personalized voice mail box of the C3000, it is no longer neces-
sary to use separate hardware components such as fax machines and tele-
phones.

The add-ons include:

FAX

Send your faxes like emails, including file attachments such as Microsoft
Office documents.

Receive faxes with Outlook and view them on-screen.

SMS

User-friendly text messaging using the C3000 SMS form.
Receive SMS text messages in your inbox just like e-mails.

VOICE

Messages from your personalized voice mailbox are sent to your inbox. Apart
from normal inquiry by telephone, you can also double-click on them in Out-
look in order to play them back using your PC's audio equipment or forward
them to listen to them on your extension (Wav-To-Phone).You can use the
phone keypad to switch backwards or forwards in the message.

Forward received voice mail messages to any telephone number.
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Introduction

FAX printer

Generate fax documents from any application and send them using Outlook.
Create broadcast circulars (mass fax/fax broadcasting) using the mail merge
function of Microsoft Word or other programs and send them using C3000.

Optional services

In addition to the standard services (FAX, SMS, VOICE), other services such
as text recognition modules (OCR) or SAP can also be added.
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Configuring your own user data

Configuring your own user data

Your system administrator can assign you rights enabling you to configure
your own user data using WebAdmin. This chapter describes the settings you
can make. Settings you are not authorized to change are greyed-out in Web-
Admin. You can read the settings, but you cannot change them yourself.

Signhing on to WebAdmin

Enter the name of the C3000 server in the web browser. You can get this from
your system administrator.

A login website is displayed.

You will need to make the following entries to log in. Ask your system adminis-
trator for the relevant data.

Field  Server address
Enter the name of the C3000 server.
Field Name
Enter the full login name you received from your system administrator.
Field Password
Enter the password you were assigned by your system administrator.
You can also set the language for the web interface.
Click on the Login button.

Tab control overview

Once you have successfully logged onto WebAdmin you will see the following
tabs:

Click on the User tab to view the following tabs:

* Common (address data)

» C3000 General (Location/Fax layout)

* Routing rules

* TUI - Configuration

* TUI - Announcements

»  Mobility Service

Click on the Documents tab to view the following tabs:
* Filter settings

« Display options
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Configuring your own user data

Selection field

Selection field

Checkbox

Selection fields

Field

Greyed-out fields signify: your system administrator has not

assigned you the necessary rights to edit this data. You can

change the other fields that are not greyed-out. Contact your
system administrator for more information.

User tab

The user information is spread across the following tabs:
*  Common (address data)

» C3000 General (Location/Fax layout)

* Routing rules

* TUI - Configuration

*  TUI - Announcements

»  Mobility Service

User tab - Common tab
System button >User tab >Common tab

Here you can change general address data.

Note You can only change values in the grey fields if your system
administrator has configured local user management and
assigned you the relevant user rights.

User tab - C3000 General tab

System button >User tab >C3000 General tab

Location

Here you enter your location.

Language for receipts

Here you can choose the language for receipts.

Insert fax footer

Activate this checkbox if a fax footer should be inserted.

Cover page, letterhead first page, letterhead subsequent pages:
Here you select your fax layout settings for the user concerned.
Signature file (TIFF)

Ask your system administrator whether they have set up a signature file for
you.

Note Optimum signature display is achieved with the following
values:

* Resolution: 96 dpi
* Height: approximately 150 pixels
»  Colour intensity: 1 bit (2 colours).
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Configuring your own user data

Example
Field

Option

Field

Field

If a signature file has not yet been set up, a message underneath the field
points this out.

Complete the following steps to assign yourself a new signature file:
1. Click on Browse.
1. Select a previously generated signature file and click on Open.

The selected signature file is linked to your name and uploaded to the
C3000 server.

The signature files are accepted by the C3000 server, provided they are in
TIFF format.

Note One signature file only can be stored for each user.

Note TIFF is a commonly used graphics file format which can be
created and edited by many graphics and scanner programs.

SIGNATURE_MEYER.TIF

Network printer URL

Enter the path for the Network Printer

Maximum number of messages in the mailbox

Select the option use global settings or limit to and enter a value.

Is the max. number of messages reached, no new message can be received.
* Busy tone for incomming fax.

« Calls will be disconnected after the announcement: “unfortunately no
message can be left".

Is the mailbox size not defined for a user then the global setting applies.

User tab - Routing rules tab

Routing rules are usually set up by your system administrator.

User tab - TUI - Configuration tab

System button - User tab - TUI - Configuration tab

This is where you configure the TUI (Telephone User Interface / Voice box).
PIN

This is where you enter the PIN for the TUI mailbox.

Fax target

The fax number entered here is used if you want to forward incoming faxes
using the TUL.

Note Fax number rules: no blank spaces, no special characters, +
sign prefixing country code permitted
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Configuring your own user data

Checkbox

Selection field

Field

Field

Checkbox

Telephone menu setup

If you, as a user, call up your new mailbox for the first time, the telephone
menu setup opens. The telephone menu setup helps you to set up your basic
mailbox.

If the check box for global telephone menu setup is activated in the net port
configuration of WebAdmin, telephone menu setup is activated for each user
who has not yet run through the telephone menu setup for their mailbox. A
successful run through is saved for the user.

» Activate this checkbox so that you, as user, can run through the tele-
phone menu setup again.

* Deactivate this checkbox so that the telephone menu setup is no longer
available to you as a user after it has successfully been run through.

Default value: Activated

Call restriction profile Voice and Fax

Default configuration: not restricted. No restriction profile is active.
Select one of the 9 profiles as restriction profile for the user.

It is possible to configure up to 9 restriction profiles in C3000 Communication
Gateway. Within each restriction profile, you can block several initial digits.

* 0049 -> All the outgoing calls for Germany are blocked.

00 -> All the outgoing international calls are blocked.

Is a user sending a document, e.g. a fax, the system checks which profiles are
assigned to this user. These profiles will be then aligned with the Communica-

tion Gateway profiles. Is a restriction profile assigned to the user but unknown
to the Communication Gateway, the send order will be executed anyway.

Is a send order not executable because of some settings in the restriction pro-
file, the user gets a negative receipt (in the configured language).

Backup PIN

Enter the backup pin. Your backup can access the main menu and play back
new and old messages. Only the confidential messages won’t be played back.

Backup number

A caller can decide, whether to be connected with the backup number (Call
Transfer) before being able to record a message. It is possible to configure up
to 9 backup numbers.

Activate the backup menu
Default value: deactivated.

Note Only basic accesses (MSN) of the telephone system are sup-
ported. (Telephone system extensions do not have standard
call transfer functionality)
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Configuring your own user data

Checkbox

Selection field

Checkbox

Fields

Using Outlook Out of Office assistant

Activate this checkbox, so that the Outlook Out of Office memo is read out (via
text to speech) instead of the info announcement in the TUI. The info
announcement is then completely blanked out in the Mailbox menu. It is then
not possible to activate the info announcement.

Default value: Deactivated
Languages

Here you can choose up to three languages for the TUI from six specified fixed
languages. The user can then switch between the languages set here in the
TUL

» If nolanguage is set here the language settings of the net port are used.

» If alanguage is set here (or two or three languages), then the net port
language settings no longer apply.

Complete the following steps to select a language:

1. Select a language from the selection field.

2. Click on Add.
— The language appears in the list below with the prefixed Recycle Bin
icon T .
— If there are already three languages in the list and you nevertheless
choose a fourth language, a message appears stating that max three
languages are supported.

— The first language in the list is automatically the default TUI language
for the user.

3. Click on the Recycle Bin icon il to remove a language from the list.

You can choose from the following languages:

+ German
« English
* French

e ltalian

e Spanish

Speech control

Activate this check box to switch on language control for the TUI.
Default value: Deactivated

Messagestore

Changes at these settings should be made only in consultation with the sys-
tem administrator.
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Configuring your own user data

User tab - TUI - Announcements tab

System button > User tab > TUI - Announcements tab

Here you set the type of announcement for your voice mailbox.

C3000 differentiates between internal and external calls. External calls are in
turn differentiated by calls received during and outside normal business hours
and calls received on public holidays.

You can choose from the following types of announcements:

Deactivated

No user-specific settings have yet been made. This is the system's
default setting. The announcement states that it is a voice info system
and gives the user's extension number.

Username
The announcement is the same as for the Deactivated option, but a pre-
recorded user name is given instead of the extension number.

Userdefined or Announcement 0,1,2...9

An individually recorded (personalised) announcement is played back.
Only one personalised announcement can be recorded for internal calls,
up to 10 different announcements can be recorded for external calls.
Greeting Without recording

An information announcement is played back only. The caller cannot
leave a message.

Complete the following steps to assign wav files to the internal and external
announcements:

1.

Click the relevant pencil icon # .

A field is displayed.
— Click Browse to select a wav file.

— Click o , to upload the selected wav file. The status-bar indicator
changes from blank to available. The wav file is not saved until you
click the Save button.

— Click on the red cross i , to cancel the current action.
Assign more wav files.
Click Save.

Note Ask your system administrator whether and where they have

stored wav files for you.

The wav file must be saved in A-Law 8-bit, mono 8 kHz for-
mat.

A-Law (or CCITT Standard G.711) is an audio compression
method commonly used in telephony applications.
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Configuring your own user data

Checkbox

Checkbox

Checkbox

Field

Field

User tab - Mobility Service tab
System button > User tab > Mobility Service tab

In the Mobility Service tab, you can consider following options:
* Enter and activate the FollowMe number

»  Configuring profiles

* Configuring priority levels

»  Configuring a schedule for the profiles

Usage allowed

It is possible to use Mobility.

External targets allowed

External targets outside of the PABX are possible.
Mailbox if no target is reachable

If it is not possible to reach the user over the priority levels, the caller will be
transfered to the mailbox.

If this option is not activated and the callee cannot be reached, the connection
ends with “The person you have called is temporarily not available”.

Follow Me

The FollowMe number (diversion number) is always dialed first. After a confi-
gured time (timeout) the dial attempt is cancelled. The Mobility Service activa-
ted profile is then executed, transfered to the mailbox or ended.

To activate this option the FollowMe number must be edited.
Target number

Enter the FollowMe number.

Timeout

Enter the time in seconds.

Default value is 20 seconds.

Accessibility profiles

Each user can have up to 5 profiles.

Each profile has 3 priority levels.

Each priority level has up to 3 numbers.

If the destinations of one priority level cannot be reached after a configured
time, the dial attempts are cancelled and the system initiates a new call to
reach destinations of the next priority level.

A profile or a schedule can be activated.

The callee is informed about who is calling. He can hang up to transfer the call
to other numbers or to the voice mailbox or he can answer the call.

If the call is connected (QSig connection), a PathReplacement will be triggered
. All other connections need 2 trunks for the time of the conversation.
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Configuring your own user data

Option

Field

Button

Do not use profiles, Use profile, Use schedule

Select one of the following options:
* Do not use profiles

* Use profile und Select a profile
* Use schedule

Timeout

Enter the time in seconds. Default value is 20 second.
Edit profiles/schedules

Dialog Accessibility profiles

In the dialog Accessibility profiles, you can assign up to 3 priority levels a pro-
file.

To each priority level you can assign up to 3 numbers. For every number, you
can select the option stop on busy. Is the destination is busy, the connection
will be cancelled. The call will be transfered on the mailbox or cancelled,
depending on the settings.

To every priority level you can assign up to 3 caller numbers (VIP numbers).
Is the caller number not a VIP number, the priority level will be skiped. If there
is no VIP number specified, the priority level will be used for all the users.

Click the green tick mark < to apply the setting.
Click the red cross x{ to undo the selection.

Click the pencil # to edit the setting.

Click the wastebasket T to delete the configuration.
Schedule tab

In the Schedule tab you can assign a profile to a time of day for every day of
the week.
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Configuring your own user data

Option

Field

Field

Field

Documents tab - Filter settings tab
System button > Documents tab > Filter settings tab
This tab is where you compile document filters.

You can use the filter settings to limit the number of documents found by spe-
cifying search criteria.

Here a distinction is made between general conditions (User, Folder, time
limits From and To) and the conditions dependent on the document type.

Click the Display button to send an inquiry.

An inquiry can only ever be submitted for one document type at a time. l.e.
incoming documents only or outgoing documents only.

The send requests are displayed for outgoing documents. The corresponding
documents can be identified by the displayed document ID.

Incoming/Outgoing

Here you select whether incoming or outgoing messages are filtered. The cor-
responding document status filters are evaluated depending on this setting.

Hits shown

Limiting the displayed hits. If the inquiry returns more hits than indicated here,
a warning is issued that the inquiry returned n hits but only x of them are dis-
played.

Value range: 0 to 99999

Note Large values sometimes result in very long loading times. You
should therefore try to limit the results list.

User

Limits the inquiry to one specific C3000 user only.

A valid user ID must be entered here.

Example: name@xx.yy

Folder

Limits the inquiry so that only documents from a specific folder are displayed.

Example: Incomming
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Configuring your own user data

Fields Date: From/To

Limits the inquiry results to a specific period of time. A date is entered in these
fields. It is possible to make an entry in one of the two fields only, i.e. to specify
all documents before or after a specific date for example.

The From time is interpreted as 00:00:00 hours on the day in question if no
From time is specified.

The To time is interpreted as 23:59:59 hours if no To time is specified.
Format: dd.mm.yy or dd.mm.yyyy
Example: 24.12.2002

Selection field  Service

Select the service you want here (e.g. Fax/Voice/SMS). The Internal service
(C3000 address) refers to messages sent within C3000. Your system adminis-
trator can provide you with more information.

Range Incoming/Outgoing

Here you can select the status indicators. The corresponding document status
filters are evaluated depending on this setting.

Checkbox  Successful

The message has successfully been sent.
Checkbox  Failed

An error occurred when sending the message.
Checkbox  Waiting

The message has not yet been sent.
Checkbox  Active

The message is currently being sent.
Checkbox  Stopped

The transmission was aborted while waiting.
Checkbox To authorize

The message must be authorized for sending.
Checkbox In progress

The message is currently being processed.
Checkbox Already tried

An attempt has already been made to send the message; further attempts are
pending.

Checkbox  Authorization denied
Authorization to send the message has been refused.
Field Document ID
Enter a known document ID to find a specific document.
Field Send-order ID
Enter a known send request ID to find a specific transmitted document
Button  Clear filter

This deletes the set filter.
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Configuring your own user data

Documents tab - View options tab
System button > Documents tab - View options tab

Here is where you configure the attributes to be displayed, and the order in
which they are shown, separately for incoming and outgoing documents.

Activate the checkbox options you want and enter appropriate values in the
selection fields.

Click Show to view the results.

Editing displayed (incoming) documents

The following three edit functions are available for incoming documents: For-
ward, Set read, Delete.

»  Complete the following steps to forward a displayed document to another
person:

1. Select the displayed document by activating the relevant checkbox.

2. Select Forward in the Action list box.

Note This forwarding function is only available if you are authorized
for the Internal (C3000 address) service.

Your system administrator can provide you with this right.

3. Inthe Destination (User) field, click the J button to select a C3000
user. Only C3000 addresses are possible here.

4. Click the Execute button.
The selected document is forwarded to the corresponding C3000 user.

»  Complete the following steps to mark a displayed document as read:
1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Set read.

3. Click the Execute button.

The selected document's status is set to Read.

* Complete the following steps to delete a displayed document:

1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Delete.

3. Click the Execute button.

The selected document is deleted.

Editing displayed (outgoing) documents

Note Queued send requests are automatically deleted after 24
hours and assigned the status Failed.

The following edit functions are available for outgoing documents: Delete,

Send, Forward, Stop.

» Complete the following steps to delete a displayed document:
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1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Delete.
3. Click the Execute button.

The selected document is deleted.

» Complete the following steps to re-send a displayed document (failed
outgoing messages only):

1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Send.

3. Click the Execute button.

The selected document is re-sent.

» Complete the following steps to forward a displayed document to another
person:

1. Select the displayed document by activating the relevant checkbox.

2. Select Forward in the Action list box.

Note This forwarding function is only available if you are authorized
for the Internal (C3000 address) service.

Your system administrator can provide you with this right.

3. Inthe Destination (User) field, click the J button to select a C3000
user. Only C3000 addresses are possible here.

4. Click the Execute button.
The selected document is forwarded to the corresponding C3000 user.

»  Complete the following steps to stop a displayed document (queued out-
going messages only):

1. Select the displayed document by activating the relevant checkbox.
2. Inthe Action list box, select Stop.
3. Click the Execute butto.n

The selected document (outgoing send request) is stopped, i.e. its status
changes from Waiting to Stopped.

Reports via WebAdmin

You can have so-called reports emailed to you via WebAdmin. Further infor-
mation is available from your system administrator and in the C3000 Adminis-
trator Manual 2.0, in the Reporting: Scheduler section.

C3000 2.1 User Manual Outlook — 01/14/2011 — Edition 1.0 20



Using C3000 for Outlook

Using C3000 for Outlook

Addressing

The functions set out in this section (forms, fax printer etc.) may possibly not
be available on your workstation. If they are not, contact your system adminis-
trator to have the necessary privileges assigned.

The new functions of C3000 UMS are first presented without use of the client
add-on.

On installation of the C3000 Exchange Connector, Exchange and its client
Outlook are notified of the following new address types:

+ C3
+ C3SMS
+ FAX

Whereas the C3 and C3SMS types are used for temporary addressing to any
services of the C3000 UMS system (such as fax and SMS), the FAX address
type evaluates the fax numbers in your Outlook address books.

Temporary with C3 syntax

An address can be entered on the standard Outlook send form. Temporary
addresses (phone/fax numbers) require a special syntax, however. To enable
Exchange/Outlook to identify the message as one that is to be sent via the
C3000 UMS system, the following syntax must be adhered in the TO: line:

Example
[C3:FX3/040236583000] - FX3/04023658300
[C3:SMS/017223658300] - SMS/017223658300

The system recognizes the address types and converts them into the usual
syntax, as shown in the examples above.

For a FAX transmission, select the service type FX3 and for a text message
(SMS) to a mobile phone select SMS.

This is set out again as an example of the standard send form.

Complete the following steps:

1. Enter an address in the required syntax and move to any other field.
The address is recognized and converted.

2. Right-click on the address and choose Properties from the popup menu.
The Properties window appears.

You will see that the e-mail type C3 is entered for both the FX3 and SMS
services.
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3. As acomparison, you can enter any internet mail address, there the e-
mail type is SMTP (Simple Mail Transport Protocol) for dispatch via the
mail system's internet connection.

Examples for FAX:
[C3:FX3/+494092929292]
FX3/+494092929292

Addressee properties:

Displayed name: FX3/+494092929292
E-mail address: FX3/+494092929292
E-mail type: C3

Examples for SMS:
[C3:SMS/017239393939]
SMS/017239393939

Addressee properties:

Displayed name: SMS/+494092929292
E-mail address: SMS/+494092929292
E-mail type: C3

Example for e-mail:

smith@company.com

smith@company.com

Addressee properties:

Displayed name: mustermann@company.com
E-mail address: smith@company.com

E-mail type: SMTP

Temporary with address templates

To avoid the complicated process of inputting the required syntax, we recom-
mend you use the system's C3000 address templates. This does require the

templates to be available in your mail system. Ask your administrator how to

do this, or look up the procedure yourself:

C3000 FAX

Complete the following steps:

1. Inthe standard send form, click the To... button to select addresses from
your Contacts or from the global address book.

2. To generate a temporary address, click on New entry... in this window
The New entry window appears.

3. Check the following option: Only in this message.
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The list box that opens up lists the available address types. If C3000
address templates are installed, C3000 FAX and C3000 SMS also
appear.

If you select the C3000 FAX entry, for example, and click OK, a window
appears in which you only need to fill out the Display and Number fields.

The entry in the Display field is then displayed in the To... field of the
message. You can fill out the field as you wish.

In the Number field enter the recipient's fax number. You can now gene-
rate the entry temporarily ( An, Cc, Bcc or button: OK) or import it into
your personal address book to reuse later.

In this case the generated fax address is treated like an e-mail, and crea-
ted in the appropriate field. The Properties dialog box displays the same
properties as the address generated with the syntax.

Whether you now import the entry temporarily or select it from your
addressbook, in both cases a message is generated to the UMS under
the displayed name.

Type your text, as for a normal mail, and attach documents to it.

Your text (the so-called MEMO) is displayed on the first page (cover
sheet) of the fax.

The Subject line is not included, and so does not form part of the fax
(except when you are using cover sheets). Attached documents are pre-
pared by the UMS for faxing (where appropriate on the configured letter-
head paper - see below) and attached to the following pages of the fax.

Note Not all document types are permissible as attachments. Your

administrator will be able to tell you which document types
(e.g. Word, Powerpoint, Excel, image formats) you can send
as attachments.

The permissible document types depend on the configuration
of the C3000 server.

C3000 SMS

You apply the same method to temporary SMS addresses. Instead of C3000
FAX select C3000 SMS only.

1.

Here, too, you can now generate the entry temporarily ( To, Cc, Bcc but-
tons, or OK button) or import it into your personal address book to reuse
later.

In the Properties dialog box for the address, instead of the fax address
the e-mail type C3SMS is now displayed.

Whether you now import the entry temporarily or select it from your
addressbook, in both cases a message is generated to the UMS under
the displayed name.

Type your text, as for a normal mail.
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Address book

Note By default only the first 160 characters (including the subject

~ line) of your SMS are transmitted. Depending on the configu-
ration of the SMS link in the C3000 UMS system, a longer text
(>160 characters) can be split into several text messages.
Your administrator can provide you with details on this.

You can also insert the new address types directly into your addressbook. Mul-
tiple addresses can be stored. Let's look at an example contact, John Smith in
To:

Smith, John

Work: +49 (040) 93939393

Fax, work: +49 (040) 930989898
Fax, private: +49 (040) 72727272
E-mail: smith@company.com
E-mail 2: John Smith (SMS)

For this contact two fax addresses are recorded (work and private) and one
SMS address (e-mail 2). The standard Outlook fax address fields can be eva-
luated by the UMS. This address type corresponds to the FAX type (see
above).

For SMS addresses (and, where appropriate, additional fax addresses) you
need to insert the E-mail field. To do so, enter the address in the field first as
described above with the syntax

for an SMS address:
[C3SMS:SMS/0163737373]
or alternatively: [C3:SMS/0163737373]

for a fax address:
[C3:FX3/0163737373]

The address is recognized and displayed as
SMS/0163737373.

To enhance the informative nature of the entry and ensure it is distinguished
from the usual e-mail address, we recommend you modify the displayed
name.

Complete the following steps:

1. Right-click on Address and choose Properties.
The Properties window appears.
Change the Displayed Name, for example to John Smith (SMS)
Click OK.

You can now enter address data in the usual way by selecting from your
addressbook.
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Example

More examples

At this point you will also see the benefit of modifying the displayed
name. The list initially shows only the name of the contact. The name of
the address field (Fax, work, e-mail or e-mail2) is indicated in brackets.
If there are several e-mail addresses of different types (Internet mail,
Fax or SMS), no distinction is made here. It is made easier if the dis-
played name is varied (e.g. John Smith [Fax, work]; John Smith [Other
fax]).

Recipient on subject line

The procedure is the same as for normal sending. The difference lies in a spe-
cial address input (default: C3COM as global contact entry) as the recipient.
In the Subject field you enter the actual recipient and send options.

Additional addressee information is written directly to the destination number/
address, separated by "/".

FX3=0408161300/John Smith/Company/Any Street 99/12345 Any town;
COVERSHEET=CoverSheetStandard;PRIO=H;New Appointments

Note Outlook limit the maximum number of characters on the sub-
ject line to 255.

The fields correspond to the following fields on the cover sheet:
Recipient, Name, Company1, Company2, Company3

Variables and options are separated by "=" or ":". Multiple variables are sepa-
rated by ";". As an option, you can enter the actual commentary as the last
entry. The following table indicates which variables are available to you.

FX3:63552525/Peter Riga; COVERSHEET=StandardDB;PRIO=H
SMS=01726262626;My Comments

Note You can only use the services for which you have been autho-
rized. Ask your administrator which services are available to
you.
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Services table

FAX3 FX3 <Number> FAX Group 3 Send job
F3

SMS <Number> SMS send job

OCR Any address OCR send job

Additional information in addressing

/Name/// <Name of the addres-  Insert additional infor-
see> e.g. Hugo Meier ~ mation in external
send jobs (cover
sheets)

//Company1// <Company name> Insert additional infor-
mation in external
send jobs (cover
sheets)

/l/Company2/ <Company2> Insert additional infor-
mation in external
send jobs (cover
sheets)

/[l/Company3 <Company3> Insert additional infor-
mation in external
send jobs (cover
sheets)

Variables table

TIME T HH:MM:SS Send time
[Hour:Minute:Second]

DATE YYYY.MM.DD Send date
[Year.Month.Day]

ACCOUNT <Cost centre> Transfer costs for cost
e.g. V4711 centre into statistics
e program...

(up to 15 characters)
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Variable

PRIORITY

COVERPAGE

PAPER

PAPER2

Variable (short
form)

PRIO

COVER

Acknowledgements

Parameter

LOW (short form: L)
NORMAL (short form: N)
HIGH (short form: H)

<Cover sheet abbrevia-
tion>

<Letterhead abbrevia-
tion>

<Letterhead abbrevia-
tion>

Meaning

Priority of the send job:
Top priority jobs are
processed first

Cover sheet

Letterhead

Letterhead following
pages

For each send job you receive a confirmation that it has been successfully deli-
vered or notification of an error in processing.

The indicated sender of these return receipts is the System administrator
and the subject is Sent: or Undeliverable.
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Requirements: Outlook Forms and Toolbars

For Outlook forms and toolbars, the following requirements apply to the Out-
look version.

Fax/SMS forms

ServicePack
Outlook 2010
Outlook 2007
Outlook 2003

Toolbars

ServicePack
Outlook 2010
Outlook 2007
Outlook 2003
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C3000 forms

With the C3000 forms, sending faxes and text messages (SMS) is made even
more user-friendly.

Three specimen forms are included. They are available for use in the following
applications:

¢ Fax transmission
e SMS transmission

To be able to use the forms they must first be made known to your Outlook
client. This mechanism is called Publishing forms.

Publishing forms

There are two basic ways of doing this:

* Publishing forms centrally: The forms are stored centrally on your mail
server (forms library in Exchange)

* Local Publication: You only use the forms personally, copying them from
the file system.

Forms library: Publishing forms centrally

In the first case the forms are made accessible to you by your administrator by
placing them in a public folder or a specially designated library (library for orga-
nizational forms/forms library). You can assign them to your inbox in Outlook
using the Form Manager.

Complete the following steps:

1. Right-click on your Inbox folder and call up Properties. Click on the
Forms tab. If you are not working with any other forms, this container is
initially empty.

2. Click the Manage... button , to open the form manager. By default it
shows the content of the forms library. If the forms are stored in it, they
are displayed (if no other forms exist). The following uses the C3000
Forms library as an example.

If the forms are located in other folders, use the Setup Button and the
window that appears to navigate to them. Your administrator will be able
to tell you where the C3000 forms are located.

3. Select the forms you want to use and assign them to your inbox by cli-
cking the Copy button in the Form Manager. Note that the names of the
forms used may differ from those in our example.

4. After copying, close the Form Manager. Your inbox's Properties dialog
box remains open. Check whether the assigned forms are displayed.

5. Click OK.

You can now access the new forms in Outlook by choosing the Actions menu
option. Please note, you will need to be in the Inbox view to do so. The first

time you open the forms they need to install, but after that you can use them
immediately. To access the forms from other views, repeat the operation set
out above for other folders.
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Local publication: Publishing forms locally

If the forms are not accessible from a forms library or another public folder, you
can publish them locally with your Outlook client.

The only requirement for this is that you have access to the forms by means
of the file system (on hard disk, CD drive or over a network).

Sequence:
1. In Outlook click on Extras >Forms >Select form ...
The Select form window appears.
2. Click the Browse... button and search the file system for the forms.

Ask your system administrator where they filed the forms for you. The
original form names are:

¢ C3kFormFax.oft
¢ C3kFormSMS.oft

Select a form and click the Open button.

Within the form, open the Tools menu again. but this time choose Forms
>Publish forms as....

The Publish forms as window appears.

5. Here the Search in selection box offers you a range of options for storing
the form in the Outlook/Exchange system. (Example: Library for perso-
nal forms).

The entries in the Displayed name and Form name fields can initially be
made as you wish.

Note If you want to use C3000 Toolbars for Outlook however (see
below), the names entered must be as follows:

« C3000FAX for the C3kFormFAX form
e« C3000SMS for the C3kFormSMS form

6. After choosing the name, publish the form by clicking the Publish button.

A security prompt appears asking whether you want to check a check-
box.

7. Answer with No.

Note If the system administrator has provided you with a particular
variant of the forms, this security prompt will not appear.

Close the form without saving it. Do the same with the other forms.

To access your form: In Outlook, select the menu option Tools >Forms
->Select form ... your form from the location where you published it (in

our example library for personal forms). When a form is selected it is

quickly installed.

10. If you assign the forms to your inbox you will have faster access to them.

Note For more information refer to the section "Forms Library: Pub-
lish forms centrally" on page 33.

11. Butin this case select Library for personal forms as the location and
not C3000Forms.

12. If you only want to assign the form for your inbox, you can specify the
inbox directly as the publication location in step 5. Step 10 is then not
necessary in that case.
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Checkbox

Selection field

Selection field

Selection field

Options

Field

Using forms: C3000 Fax

On this send form you only need to enter the respective numbers as the
address for temporary addressing purposes. You can also enter combined
addresses (temporary, address book, e-mail, FAX, SMS). As fax send options
you can select cover sheets, the priority and a fax send ID applicable only to
this specific send job.

You can use the Outlook messaging options to configure a send date. Further
information is available in the section "Send deferred fax" on page 37.

Below the three tabs you can see the Save settings checkbox.
Save settings

Activate this checkbox to save the settings you have entered, if you change
the form and reopen it.

Cover sheets tab

The cover sheet, letterhead and following page are individually preconfigured
layout elements provided by the server.

Select your cover sheet, letterhead and following pages from the correspon-
ding selection boxes.

Cover sheet

Select the cover sheet you want to use from here. When you use cover sheets,
placeholders are also replaced automatically. In this way the positioning and
formatting of dynamic cover sheet text elements (e.g. current date, recipient's
name and address, a signature or introductory letter) can be taken into
account when designing the cover sheet layout. All the possibilities of the RTF
format can be utilized, including graphics and the full range of fonts and font
sizes.

Letterhead

Select the letterhead you want to use from here. If you are sending a docu-

ment attached to your message, you can assign a letterhead to it. When let-
terhead documents are sent the graphics created during conversion are sim-
ply overlaid, corresponding to the use of pre-printed letterhead when printing.

Following page
Select the letterhead paper to be used for page 2 and subsequent pages here.

Tab: Send options
Priority

You can underscore the urgency of your send job by increasing or reducing its
priority. Select the option you want (Low, Normal, High). The UMS prioritizes
higher-priority faxes if there is a queue.

Fax send ID

Normally your fax send ID (the sender number on the top status line of a fax)
is preset by the system. If you enter a number in this field the system settings
are overwritten.
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Checkbox

Checkbox

Selection field

As a general rule:

The fax send ID is composed of two parts: The basic ID and extension. The
fax send ID is generated by the system based on the following rules:

* Rule 1: If a job-dependent fax send ID (defined in Outlook) exists, it is
used. Otherwise rule 2 applies.

* Rule 2: If the user-specific fax send ID (defined in user management by
the administrator) is set for the user concerned, it is used. Otherwise rule
3 applies.

* Rule 3: The system attempts to compile the ID from the default basic ID
and the user-specific fax extension (defined in user management by the
administrator). If the fax extension is also unknown, rule 4 applies.

* Rule 4: The ID is compiled from the default basic ID and the default
extension.

Tab: View
Cc

Check this checkbox to specify the recipients to whom you want to send a
copy.
Bcc

Check this checkbox to specify the recipients to whom you want to send a
blind copy.

Voice

Select the tab/form language here: You can choose between DE for German
and EN for English. Other languages (e.g. FR for French) have to be installed
(see C3000 Installation Manual in the section Install other languages).

Send deferred fax

Note To send a deferred fax , i.e. at a later time, use the Outlook
messaging options described in the following.

1. On the C3000 fax send form click the Options button.
The Messaging options window appears.
Activate the Delay transmission until checkbox.
Click on the arrow on the selection box.
A calendar appears.
4. Select the required day.
5. Type in the required time by overwriting the time shown.
6. Click the Close button.

When you now click Send the fax is held in your Outbox folder until being
sent at the set time and date.
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Selection field

Button

Using forms: C3000SMS

In this send form you only need to enter the respective numbers as the
address for temporary addressing purposes or you can select an SMS
address (e-mail) from the address book by clicking e | .

Tab: View
Voice

Select the tab/form language here: You can choose between DE for German
and EN for English. Other languages (e.g. FR for French) have to be installed
(see C3000 Installation Manual in the section Install other languages).

Check SMS =

Click the Check SMS button == {0 view the number of characters. If there
are more than 160 characters the text is automatically split across multiple
SMS text messages.

Below the three tabs you can see the Save settings checkbox.

Note By default only the first 160 characters of your SMS are trans-

T mitted. Depending on the configuration of the SMS link in the
UMS, alonger text (> 160 characters) can be split into several
text messages.

C3000 Toolbars
With the C3000 Toolbars you can access the C3000 forms quickly and easily.

Requirements

The forms have previously been published under the names C3000FAX,
C3000SMS and C3000VOICE.

Operation

After being installed the toolbars appear as additional buttons on the Outlook
toolbar.

When you click on the new buttons the required form appears.

Meaning

- Opens the FAX form.
| & cannorax

Opens the SMS form.

| % Ca000sms

Deactivating buttons

You can also deactivate the new buttons. From the View menu choose Tool-
bars and deactivate the relevant entries.
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Contacts

In your Contacts view select one or more entries and then click on one of the
C3000 buttons. If corresponding telephone numbers are entered, they are
automatically entered in the address line of the form.

Note The only fields evaluated are:
» for fax addresses (C3000FAX) the field Fax work
+ for text messages (C3000SMS) the field Mobile phone
» for voice messages (C3000VOICE) the field Work

Wav-to-Phone

With C3000 for Exchange you can also receive voice messages (from your
personal voice mail) in the form of wav files (Windows format: CCITT A-Law,
8.00Khz, 8-bit, mono, file extension .wav) in your Outlook inbox. You can play
them back using the usual sound hardware. If you have no sound hardware
on your PC, you can have the voice message forwarded to your telephone for
playback. This is why this option is known as Wav-to-Phone.

Checking settings

All the settings applicable to you are usually made on installation. The Wav-
to-Phone option is active by default. It can be deactivated however. In this
case the messages are played back on your PC's audio hardware.

Note Wav files not in the above format are not played back over
your telephone.

To access the wav files directly from Outlook, first deactivate Wav-to-Phone.
The file is then played back by Windows Media Player (or a comparable asso-
ciated application).

Deactivating Wav-to-Phone

Sequence:

1. Select the menu Extras->Options.
A window appears.

2. Click on the WAV To Phone tab and deactivate the Activate the C3000
Wav To Phone Player checkbox.

3. Inthe Extension field you can change your extension number or enter
any other telephone number.

Note When you double-click on the wav file the message is sent to
your telephone: Your telephone rings. As soon as you pick up
the wav file plays.
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Wav-to-Phone: Switch backwards and forwards in messages

While you playback a Wav-to-Phone message on the phone you can skip for-
wards and backwards in this message.

1. While the message is being played back, press the [7] on the phone key-
pad.

You then skip to 5 seconds later in the message.

2. While the message is being played back, press the [9] on the phone key-
pad.

You then skip to 5 seconds back in the message, i.e. the last 5 seconds
are repeated.

Play voice message on the phone

In the message window
* Double-click the voice message.
* Click the right mouse button on the voice message.
In the context menu, click Play message on the phone.
In the Outlook preview window
* Click the right mouse button on the voice message.
In the context menu, click play Play message on the phone.

Restriction: The playback of the voice message by double-clicking is not sup-
ported in the preview window.

Error

» If you receive a message indicating No Line Available (No Line Avai-
lable!) it may be due to the following causes:

* The application cannot be initialised by the C3000 system.

e The line is busy.

* The telephone number cannot be reached (non-existent).

Check your settings and try again a short time later. If the error persists, con-
tact your administrator.
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C3000 fax

With the C3000 fax printer you can generate a fax from any print-compatible
application. The document is converted into fax format locally on your compu-
ter.

Complete the following steps:
1. In the application, select the menu File >Print.
2. Select the fax printer as the printer; its name is C3000 Fax.

3. You can select the output quality using the so-called dither method. To do
this, click the Advanced button.

A window appears in which you can configure the Dither Method.

Note The dither method is a means of converting colour images
and documents into a black-and-white raster.

The Advanced button is only visible if your administrator has
assigned you the relevant permission (via User defined)

The dither methods have the following meanings:

Explanation

compact + Advantage: Smaller photo files

+ Disadvantage: Lower output quality of colou-
red text and photos.

quality » Advantage: Higher output quality of coloured
text and photos.

» Disadvantage: Larger photo files
» If the document contains only black-and-white

type the result is identical to the Compact set-
ting.

Depending on the selected setting, following successful conversion
(=printing) either the standard Outlook mail window or the C3000FAX
form is opened up and the document is attached as C3000FAX.tif.

You can address it in the way described above.

Which form opens up is configured in the printer's Properties. When
selecting the printer, before generating the print job click the Properties
button and then Advanced. From the selection box in the window that
opens you can then select Outlook Fax for the C3000Fax form or Out-
look Mail for the standard mail window.

Note If you cannot change any of the settings contact your adminis-

trator.
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C3000 fax machine settings

The settings in User mode show the C3000 Option entry only. More printer
configuration options can be set by accessing the printer via the operating sys-
tem's Control Panel.

Note As a user, you can read the following configuration options but
cannot change them.

Complete the following steps:

1. Select Start >Printers and Faxes.

2. Right-click on the C3000 Fax and click on Properties.
The C3000 Fax Properties window appears.

3. Click the Device Settings tab.

Note Changes to the following settings are usually only made by
your system administrator.

Select PDF in the field File Format.

Use the standard default in the field Temp Directory. The system admi-
nistrator can change the path if necessary.

Select Outlook Fax from the field UM Option.
Select Mail client from the field Connect to.
Click OK to save the settings.
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C3000 Mail Merge Function

Identifier

The mail merge function uses a global contact entry (standard: C3COM) to
send the messages, as in the case of recipient on subject line. However,
addressing is not by way of the subject line in Outlook, but is entered in the
form letter itself. On the last line a placeholder (command line) is inserted con-
taining the type of service, the address and the send options. These fields can
be used in the application for the mail merge function. The job is printed in the
background, with no further input prompts or actions in Outlook itself.

C3000 mail merge, example: MS Word

This function is explained using the example of creating form letters with MS
Word, although you can do this in a similar way with any other text processing
program.

Define an ordinary form letter in MS Word. The data source, i.e. the address
origin, may be a Word data source or any other data source accepted by Word
for form letters (e.g. an Excel worksheet).

The important thing is that the data source must include a field for the respec-
tive fax number of the addressee. You can specify the field name as you like,
or you can simply name it Fax No. or Fax number. In the following example we
use the field name C3000Fax.

When creating the text, insert an instruction (identifier) at the end (!) of the text,
on a separate line (!), with the following general syntax:

(C3#Service:PARAMETER;Variablel:PARAMETER;VariableX:PARAMETER; . . .#C3)

Example

An identifier always begins with (C3# and ends with #C3). The various com-
mands are embedded between the two identifiers. The identifier contains a
service and 0..n variables. The order is irrelevant.

An error is displayed if an identifier contains several services or unknown ser-
vices / variables. The document containing the error is not sent.

Note » The last command is not followed by a semicolon, but is
- directly followed by the terminating identifier #C3).
+ Placeholders must be on the last page of the document.
The identifier is hidden when the document is imported
into the fax. The document's formatting is retained. Posi-
tion the identifier at the end of the document.

A conceivable, very simply structured command to send a text to fax number
(040)223344 would be:

(C3#FX3:040223344#C3)
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Word form letter

Notations

Note + The overall identifier may not extend beyond more than
- one line. If you use several variables in the identifier, you
can minimize the font size so as not to exceed the line.
» The layout within an identifier must remain consistent,
i.e. the font, font size and style may not be changed. The
identifiers C3# and #C3 must be written with an upper-
case C.

» If variables are contradictory, the error is displayed and
the job is aborted.

* The identifier is limited to 500 characters in the printer
driver.

» In Outlook parts of the identifier are transferred into the
subject line, limited to 256 characters.

» If there are more than 256 characters the job is aborted
and the form letter is not sent. So wherever possible you
should use the short forms (see following tables).

If you insert such a command in a form letter, instead of inserting the fax num-
ber manually you use the data source field:

Examples of identifiers for Word form letters:
(C3#FAX3:<<C3000Fax>>#C3)
or

(C3#<<Service>>:<<Address>>#C3)

If you are using multiple variables, e.g. to specify the time of sending too,
separate each of these variables with a semicolon:

(C3#<<Service>>:<<Address>>;TIME:22:30:00#C3)

Different notations for variables and parameters

There are long and short forms for commands and their parameters, and occa-
sionally abbreviations are also used. For example, instead of entering HIGH
as the priority you can use the abbreviation H. Use the long form wherever
possible, as it will be easier to associate later. The short forms are useful if you
want to use a large number of variables and so would otherwise exceed the
line limit.
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Services table

FAX3 FX3 <Number> FAX Group 3 Send job
F3

SMS <Number> SMS send job

SMTP <email address> E-mail send job

SAP <SAP address> SAP send job

FSI <Address> FSI send job

ARCHIVE <Address> Archive send job

Variables table

NAME <Name of the addres- Insert additional informa-
see> e.g. NAME: tion in external send jobs
Meier.Hugo (.Hugo is (cover sheets)
optional)

COMPANY <Company name> Insert additional informa-

tion in external send jobs
(cover sheets)

COMPANY?2 <Company add-on> Insert additional informa-
tion in external send jobs
(cover sheets)

COMPANY3 <Company add-on> Insert additional informa-

tion in external send jobs
(cover sheets)
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Variable Variable (short
form)

TIME T

DATE

PRIORITY PRIO

COVERPAGE COVER

PAPER

PAPER2

ACCOUNT

FILE

Parameter

HH:MM:SS

[Hour:Minute:Second]

JJJJ.MM.DD
[Year.Month.Day]

LOW (short form: L)

NORMAL (short form:
N)

HIGH (short form: H)

<Cover sheet abbrevia-
tion>

<Cover sheet abbrevia-
tion>

<Letterhead abbrevia-
tion>

<Cost centre>

e.g. V4711

(up to 15 characters)
Complete path and file
name. Several files are

each separated by a
comma.

Configuring send settings

The following settings can be made for sending form letters:
* Mail system to use
» Display global contact for sending

» Send status report

Complete the following steps:
1. Click on Start >Execute.

2. The Execute window appears.

Meaning

Send time

Send date

Priority of send job: Top
priority jobs are
processed first

Cover sheet

Letterhead

Letterhead following
pages

Transfer costs for cost

centre into statistics
program...

Attach files to document

3. Enter the following command in the Open field: C:\Program

Files\Avaya\C3000\Fax Printer\umsbmail

Hinweis

4. Click on Form Letter >Configuration.

The path depends on the Installlation.

5. In the window that appears check whether Exchange is selected as the
mail system to use.
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6. Inthe Settings area, enter the global send contact. Your administrator
can tell you what it is. The standard entry is C3COM.

7. Automatically quit send status option

Here you can decide whether to view the jobs created at the end of the
print operation. This is of particular interest if errors have occurred.
Select whether the send status is to be displayed always (do not quit
option), only in the event of errors (if OK option) or never (always
option).

You receive a send status report.

Example:

Job no. 1 to C3COM - FX3=i8161300 job created.
Job no. 2 to C3COM - FX3=i8161200 job created.
Job no. 3 to C3COM - FX3=i8161300 job created.
Job no. 4 to C3COM - FX3=i8161300 job created.

Send jobs containing errors are flagged accordingly.

Note The send status only indicates whether a send job was able
to be created for each address. Outlook notifies successful or
failed transmission of each job individually.

8. Click OK.
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OCR (automatic text recognition)

OCR

= Optical Character Recognition

The OCR service is used to convert text documents in graphical format (e.g.
faxes) into editable text documents.

OCR can be used to automatically convert incoming fax messages. You then
receive a message with the original fax as in TIF file format plus the converted
version in RTF format. Your system administrator uses routing rules to set up
automatic conversion of incoming faxes for you.

As a user, you can also send faxes from your inbox to yourself manually via
the OCR service. You then receive the converted documents in RTF (Rich
Text Format) format in your inbox. This facility is described in this section.

Note You can only use OCR to send documents to yourself. You
cannot send them to other addresses.

Fax routing:

You can use the OCR service to forward a fax document in your inbox to
yourself as a message.

Forwarding a fax with OCR

Complete the following steps:

1. Select the fax in Outlook.

2. Click the Forward button.

3. A message window appears.

4. In the To field: field make an entry in the following form:
[C3:0CR/OCR]
with OCR indicating the type of service.

Note The entry after the slash "/" is ignored by the system. You
automatically receive the converted (RTF) file in your inbox
again.

5. Send the fax.

OCR converts the fax into an RTF file and places it in your inbox.
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Fax-on-demand

Complete the following steps to make documents available for requesting from
the fax-on-demand service in C3000:

1. In Outlook click on Actions »>New message.
A message window appears.

2. Inthe To field: make an entry in the following form:
[C3:FOD/Retrievalnumber]

where FOD represents the service for the fax on demand and the FOD
number representing the number (extension) from which the document
can subsequently be retrieved as a fax.

Enter a text for the document in the Subject field.

Click on Insert = File and enter the document to be made available for
fax on demand.

Note The fax-on-demand document must be in RTF format.
5. Click Send.

The document is now ready for requesting from the fax-on-demand ser-
vice on the specified number.
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C3000 Network Printer

This topic describes how you can use the C3000 network printer to send
documents as a fax or SMTP to send them as an e-mail.

Set up and send

You can use the C3000 Network Printer to send a fax or e-mail. You must set
up a C3000 Network Printer first. Ask your system administrator for the name
of the C3000 Network Printer.

Setting up a network printer

Complete the following steps to set up a network printer at your workstation.

1.

© © N oo

Click Start - Printers and Faxes. The Printers and Faxed dialog box
appears.

Click Add Printer. The Add Printer Wizard dialog box appears.
Click Next. The Local or Network Printer dialog box appears.

Select the option @ A network printer, or a printer attached to
another computer.

Click Next. The Specify a Printer dialog box appears.

Select the option & Connect to the following printer.

Enter the name of the printer or browse for a printer in the directory.
Click Next.

Click Finish. The network printer is set up.
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How do | send a fax?

You can send a fax from any Windows application that can print.
Complete the following steps:

1. Start the Windows application from which you want to send the fax. Enter
your fax text.

2. Enter the fax number and other details directly in the document via codes
codes as described in Kapitel ,Which code can you insert?* auf Seite 47.

3. Save the document.

Print the document. Select the printer. The document is now sent as a
fax to the fax number given by you in the document.

How do | send an e-mail?

You can send an e-mail from any Windows application that can print.
Complete the following steps:

1. Start the Windows application from which you want to send the e-mail.
Enter your email text.

2. Enter the e-mail address and other details directly in the document via
codes codes as described in Kapitel ,Which code can you insert?* auf
Seite 47.

Save the document.

Print the document. Select the printer. The document is now sent as an
e-mail to the e-mail address given by you in the document.
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Codes in the document

Which code can you insert?

Examples of all codes to be directly entered by you in the document are given
in the following:

Codes used in the , in
the C3000 Standard

Example in the C3000 Standard profile

profile
To: Fax number FAX %FAX=04532-1234567%
To: E-mail address SMTP %SMTP=karl.muster@company.com%..........
Subject of an e-mail SUBJECT %SUBJECT=This is the subject% .................
Priority PRIORITY %PRIORITY=MEDIUM%
Required send date DATE %DATE=20050307%
Required send time TIME %TIME=103000%

Cost centre for statistics
Fax cover sheet

COST_CENTRE
COVER

%COST_CENTRE=MarketingDepartment%
%COVER=FaxTemplate_CoverSheet.doc%

Fax letterhead - 1st page LETTERHEAD1 %STATIONERY 1=FaxTemplate_1stPage.doc
% 56

Fax letterhead (stationery) = LETTERHEAD2 %LETTERHEAD1=FaxTemplate_1stPage.doc
% 56

Form letter LAST_PAGE %LAST_PAGE=TRUE%

Recommendation

We recommend you enter the codes in the footer of the document to be sent.
The codes are evaluated by the system and replaced with blank spaces. If the
codes are outside the footer and are replaced by blank spaces, this could
change the layout of the original document.

Note

The codes must be created in one character set which is the
printer’s standard character set.

For the code key (everything written in the above examples
between “%” and “=”), only letters and “_” are allowed.

The user’s system administrator can change the code types in WebAdmin
(C3000 Network Printer @ Component 0 Profile Administration tab).
The system administrator can also use other characters instead of “%” and “=".
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Form letter

When printing a word form letter the codes must be on the last side of each
records. Additionally to standard codes the code %LAST_PAGE=TRUE%
must be added.

Additional information

Further information is available to your system administrator in the C3000
Administrator Manual in the section “How do | configure the C3000 network
printer in C3000 WebAdmin?”.
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Example

The following text shows an example of a fax message.

Fax message

Firm Street Town/City

Sender's address

Tel: 04532 / 123456
Fax: 04532/123456

Recipient's name

Company name
Street
Town

Town/City, Date
<This is the message text
Yours faithfully

signature

%FAX=123456789%
%COVER=FaxTemplate_CoverSheet.doc%
%LETTERHEAD1=FaxTemplate Letterhead%
%LETTERHEAD2=FaxTemplate_FollowingPages%
%COST_CENTRE=MarketingDepartment%
%LAST_PAGE=TRUE%
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Tips and Tricks

Configuring Outlook XP

Outlook XP read receipt:

Transmission of a read receipt to the Exchange Server/C3000 Exchange Con-
nector must be configured separately in Outlook XP. This is of special impor-
tance with regard to the use of C3000 signalling on the terminal device, as
otherwise the signal would not be cleared after signalling.

1. From the Client menu choose Tools -Options and click on the E-Mail
Options button.

2. Click the Routing Options button.
A window appears.

3. Activate the Always send a response option.

Cover sheets in public folder

The cover sheets available on the C3000 server are made available by the
Exchange Connector in a so-called Public Folder.

Default folder for cover sheets

The default folder is.

Public folders \ All public folders \ C3000\

Enter a different folder for cover sheets

A user can also create other folders under Public Folders.

You have to manually enter the new folders in the Windows registration in the
character string Registration address. The character string is not generated
by Setup.

HKEY_CURRENT_USER\SOFTWARE\Avaya\Outlook Client\Forms\Folder-
CoverPage
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